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ShareScope  
Getting Started Tutorial

ShareScope is designed to be extremely easy to use. It does, however, 
have a vast array of features. We strongly recommend that you follow 
this tutorial first – it will teach you the basic structure and features of 
ShareScope in around 20 minutes.

Starting up ShareScope
When you start up ShareScope, a number of windows may automatically display 
on your screen:

New Features in ShareScope 
This explains any new features included in the current release of the software. 
This document also provides links to previous release notes as well. It is well 
worth reading this document to find out about useful new additions to the 
program. Close the window for now – you can find it later in the Help menu (see 
page 14 for information about Help).

Comms Setting
If you have a demonstration copy of ShareScope you can ignore this step. 

In order to update your stock market data, ShareScope needs to be able to 
communicate with the outside world. 

When you first start ShareScope it will prompt you to check that the comms 
settings are correct. Click OK to display the Comms Setting dialog. By default, 
ShareScope is configured to communicate using your internet account and 
should not require further configuration by you. 

If you do not have an internet account, you will need to configure ShareScope 
to use a modem. Click on the Help button in the bottom right corner of this 
dialog box for further instructions. This dialog can subsequently be found under 
Comms Setting on the Comms menu.

Tip of the Day
This is a great way to learn about the features of ShareScope. A new tip will be 
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displayed each time you start ShareScope. You can switch this off if preferred. 
This feature resides in the Help menu. Close it for now.

Intraday feed levels (ShareScope Plus/Pro only)
This allows you to select what level of data feed you would like to receive for 
each of the markets. Click on Next when this dialog appears and make your 
selection in the next dialog. The Maximum level is tick-by-tick live data, Normal 
is 15-second snapshot prices and Minimum is 1-minute snapshot price data. 

You can only receive the Minimum level of data in ShareScope Plus. In 
ShareScope Pro we recommend you use the Normal level. 

Click on Finish when you have made your selection. You can access this dialog 
again at any stage in the future by going to the Comms menu at the top of the 
screen and clicking on Select intraday feed levels.

Updating your data
If you have a demonstration version of ShareScope you can ignore this step. 
Although the demo includes historical data, you cannot update unless you are a 
registered subscriber.

When you first install ShareScope you will have nearly all of the historical data 
and may only be missing the last few days’ data. There is no intraday data (or 
news stories) in the program when you first open it.

End of day data
The Update Data feature will update ShareScope’s end of day database to 
include all data up to and including the previous day’s closing prices as well as 
news stories and fundamental data. To download the data click on the Update 
Data button (with the PC and green arrow) on the toolbar. Alternatively you can 
press F9 on your keyboard. You will notice that the Update window includes the 
latest date of the data being downloaded, the close value of the FTSE 100 and a 
daily message from ShareScope. The following data is available:

UK end of day data is available from 18:00 every week night.

Daily fundamentals are available from 12:00 every trading day.

US stocks (ShareScope Plus/Pro only) and US indices are available after 
22:00.

Unit trust data is available daily at 22:00 (ShareScope Plus/Pro) or every 
Friday at 12:00 (ShareScope Gold).

Nikkei and Hang Seng indices are available at noon every trading day.

Every time you update, ShareScope will download all data not already 
downloaded. ShareScope uses the update process to deliver its InfoCentre 
documents. Some of these display automatically after an update. 

•

•

•

•

•



�

Intraday data (ShareScope Plus/Pro only)
To receive intraday data you need to press the Connect button (depicting 
lightning) on the toolbar. Alternatively you can go to the Comms menu and select 
Connect to intraday feed. ShareScope will backfill all of today’s data up until 
the time you connected (or 15 minutes ago if you have ShareScope Plus). You 
can check your status in the bottom right-hand corner of the screen. When the 
backfill has finished your status will read Connected. 

So long as you remain connected you will continue to receive the intraday 
data. If you disconnect (e.g. by clicking on the toolbar button again) and then 
reconnect later in the day, ShareScope will backfill the missed data. 

Once you are connected you can backfill intraday data from previous days. Go to 
the Comms menu and select Backfill intraday history. Select the markets for 
which you want to see the data, then select the days and click on the Request 
button. Note that you can only backfill data when your status says Connected.

The basic structure of ShareScope Gold
ShareScope Plus/Pro members, please go to “The basic structure of 
ShareScope Plus/Pro” on page 5.

ShareScope has several types of screen, each dedicated to showing different 
kinds of information, and learning to find your way around is the first step to 
making ShareScope a productive tool for your investment activities. 

The three main screens in ShareScope Gold are listed below and each will be 
covered in more detail. 

List The List screen displays a given list of 
stocks and other securities (Gilts, Unit 
Trusts, etc) covered by ShareScope.

Historical Graph (often referred 
to simply as the Graph)

The Graph displays the price history of the 
share currently selected in the List screen.

Details The Details screen displays results and 
forecast information for the selected share.

Press the Enter key to switch from one screen to the next in the order List > 
Graph > Details > List. Use the Esc key to scroll through in the reverse order.

As you will have gathered, the Graph and Details screens display information for 
the share that is currently selected on the List screen. Whilst viewing the Graph 
or Details screens, press Space to display information about the next share in 
the list. Press the Shift key and Space at the same time for the previous share 
in the list. 

Finding a Share
To find a share from any screen in ShareScope Gold: 

Simply start typing the first few letters of its name.  1.
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A dialog box is displayed with a selection of shares that match the letters 
you have typed. The name of the list you are using appears at the top of 
the Find a Share dialog box. Only shares from this list are available for 
selection.  

Double-click on the share you are interested in. 

The Graph or Details of the selected share will be displayed, or if you are 
viewing a List screen, that share will be highlighted. Note that Find a Share does 
not work when there is a menu or other dialog box open on the screen.

Now let’s look at each of the main ShareScope screens in more detail. Please go 
to “List screen” on page 7.

The basic structure of ShareScope Plus and Pro
Multi-windows
ShareScope Plus/Pro has a multi-window format. This enables you to view 
different types of information simultaneously: graphs, lists, company results, 
trade information, news, and directors’ dealings etc. 

To make a particular window active, click in the blue title bar. You may notice 
that some of the menu headings and toolbar buttons at the bottom of the screen 
change depending on which window is currently active. If you want to maximise 
a window to fill the entire ShareScope screen double-click on the title bar or 
press the = key. Repeating the action returns the window to its previous size.

Window Layouts
The arrangement of windows in the ShareScope screen are known as Window 
Layouts and can consist of one or more windows. The layout on the screen 
when you first open the program is called “Main Layout” and consists of a List 
Table, two Intraday Graphs, a Historical Graph and a Details window. 

ShareScope provides a number of pre-set Window Layouts. Click on the 9 
Graphs, One Share or Portfolio buttons at the bottom of the screen to see 
some of these. You can have up to 12 layouts. Go to the Window menu at the 
top of the screen, then to Window layouts to view all 12. Most of these have 
been left blank for you to customise. You can also add more layout buttons to the 
toolbar – for information on how to do this, see the Toolbars section in the on-
screen Help.

You can easily add a new window to a layout. Right-click anywhere in the screen 
and go to New Window, then select the type of window you would like to see. 
You can resize the windows by moving your cursor to the edges of the window 
and when the cursor changes to a double headed arrow, left-click and drag your 
mouse to move the edge of the window. To move the window to a new position 
on the layout, left-click on the title bar of the window and drag the window.

Linking windows
You can link windows together so that information for the same selected share is 
shown simultaneously in any number of windows on the same layout. 

2.
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Looking at the Main Layout (from the Window menu select Window layouts : 
Main layout), the two graphs at the bottom of the layout and the Details window 
are all are linked to the list of shares. You will see that their title bars all have the 
same number on the left “01” and say “(Linked)”. Whichever share is highlighted 
in the list, the same share will show in the other three windows.

You can move to the next share in the list by pressing Space and all of the linked 
windows will change to display the next share in the list. Press Shift and Space 
together to move back up the list.

To link one window to another, first select the window, then go to the Window 
menu at the top of the screen and select Link window. In the dialog that 
appears select the window you want to link this window to. The window you 
linked will now show data for the same share as the window you linked it to. 
There is of course also an Unlink option.

Restoring the default Window Layouts
Once you have finished this tutorial you may wish to re-set your Window Layouts 
to how they were when you started ShareScope up for the first time. If you 
haven’t closed ShareScope down since starting the tutorial, select Window 
: Window Layouts : Save and restore : Restore all window layouts. 
ShareScope will revert to how it was at the beginning of your session. 

If however you have made changes and exited the program in the meantime, 
ShareScope will have saved your changes. In this case select Window : 
Window Layouts : Default window layouts and ShareScope will be restored 
to how it first appeared. Please be aware that with this option you will lose any 
layout changes you have made.

Main screens in ShareScope Plus/Pro
The four main screens are listed below and each will be covered in more detail. 

List The List screen displays a given list of 
stocks and other securities (Gilts, Unit 
Trusts, etc) covered by ShareScope.

Historical Graph  (often referred 
to simply as the Graph)

The Historical Graph displays the price 
history of the share currently selected in the 
List screen.

Intraday Graph The Intraday Graph charts the price 
movement and trades of the currently 
selected share throughout the day.

Details The Details screen displays results and 
forecast information for the selected share.

The Enter key switches from one screen to the next in the order  List >  
Historical Graph > Intraday Graph > Details > List. The Esc key scrolls through 
in the reverse order. 

Click on the List window and try this out for yourself. As you use Enter or Esc 
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to go through the screens, you will notice that these Graph and Details screens 
display information for the share currently highlighted on the List screen. 

Finding a Share
To find a share from any screen in ShareScope simply start typing the first few 
letters of its name. A dialog box is displayed with a selection of shares that match 
the letters you have typed. There are three ways of searching for shares in 
ShareScope Plus/Pro:

Search by typing the name of the share and getting ShareScope to start 
searching from the first letter (Start from first letter option).

Search by typing the EPIC code (Use EPIC codes option).

Use either any part of a share name OR the EPIC code, depending on 
what you have to hand (untick both search options).

The dialog will only show shares from the list you are currently using. The name 
of that list appears at the top of the Find a Share dialog box. Select the share 
you want from the displayed list, and, if requested, specify the share type you 
want to view. The selected share will now be showing on your screen.  

List screen
We will start by looking at the List screen. If you’re using ShareScope Gold, 
press Esc to move to the List screen. If you are using ShareScope Plus/Pro, 
for the purposes of this tutorial we will work with a single maximised window. 
Double-click on the title bar of the List window to maximise it. Don’t forget that 
you can always double-click again to restore the window to its previous size.

The List screen acts as the source list for the Graph and Details screens so, 
for example, if the List screen shows the FTSE 100 sorted by capitalisation, 
then this is the order in which shares will be displayed in the Graph and Details 
screens. Chartists in particular find this an easy way to scan through price charts 
looking for trading signals.

The title bar of the List will tell you which list of shares you are currently 
viewing. You can customise the List screen to show only the information you are 
interested in.

By default, the List screen in ShareScope Gold lists all the securities for 
which ShareScope contains data. These are: all ordinary shares, convertibles, 
preference shares, warrants, investment trusts, gilts, commodities, exchange 
rates, unit trusts and indices. You can limit the list to show any of these sub-
categories. The first six buttons on the main toolbar provide a shortcut to some of 
these options but for the full list, click on the View menu. 

In ShareScope Plus/Pro, the default list is the FTSE 100. You will notice that 
there are toolbar buttons for some of the lists, for example Indices. For all 
available options look under View : Change List.

You can easily add new toolbar buttons for the categories that you look at most 
frequently. Right-click within the toolbar and select Customise Toolbars. You 

1.

2.

3.
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can further limit your lists to show just the shares that have reached a new high 
or low, or show shares from a particular sector. To do this right-click in the middle 
of the list and go to New Highs/Lows and click on New Highs or New Lows, or 
go to Select Sector and click on Choose the sector. 

A nice feature of ShareScope is its pop-up graphs. Hover the cursor over a value 
in the EPS column, for example, and you will see a small graph appear. Note: if 
you are using ShareScope Plus/Pro click on the Table 3 button at the bottom of 
the screen to go to a List Table showing EPS. Pop-up graphs give a snapshot of 
the share’s historical and forecast performance and are available for EPS, EPS 
growth, PEG, P/E, Profits, Turnover, Dividend and Yield. In fact you can hover 
the cursor over many fields in the List screen (and in other ShareScope screens) 
to display tool tips giving extra information.

You will notice that the List screen contains a number of columns containing 
details about the share price and other selected fundamental (financial) 
information. The information that is displayed is entirely up to you. You can 
configure ShareScope to display only the information that you use to make 
investment decisions. There are nearly 200 different types of column that you 
can add to a List screen. Right-click within a column heading to see the list of 
available options.

By default, ShareScope will display shares for which it contains historical data 
but which are no longer listed on the stock exchange (for whatever reason). 
These are coloured green. To remove these shares from the list, click on the 
View menu and select Show historical shares to remove the tick.

ShareScope provides 12 templates that you can use to organise different 
information. These are called List Tables. Look at the shortcut buttons at the 
bottom of the ShareScope screen. Click on each of the buttons (e.g. Table 2 and 
Table 3) in turn to see examples of different types of data displayed. Click on 
the List Tables menu to access all 12 – many of them are left blank for you to 
populate. ShareScope will automatically remember the changes you make to a 
List Table. 

To access the functions available to you whilst in the List screen, right-click 
within the list to display the List context menu. You can also access this menu 
by clicking on the List menu. To change the look and design of the List Screen, 
select List Design.

Now press Enter to move on to the Historical Graph screen. 

Historical Graph
The Historical Graph is the screen displayed when ShareScope Gold is run for 
the first time. In ShareScope Plus/Pro this screen is initially displayed in the 
bottom right-hand corner. You can also click on the Graph button on the toolbar 
(denoted by a picture of a graph) to display the Historical Graph screen.

The Historical Graph shows the price history that ShareScope holds for the 
selected share. By default the entire price history that ShareScope contains for 
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that share is displayed. However, you can zoom in to a specific period of the 
price history by clicking and dragging the mouse cursor to indicate the period you 
wish to view. Click and hold the mouse cursor anywhere on the chart, drag the 
cursor to a new position and then release it to see how this works. Double click 
on the graph to return to the full price history. 

You will notice a small window within the Graph screen showing the Legend. 
This gives useful information about the share, its price history and the graph 
itself. If you move the cursor around the screen, you will see how this information 
changes according to the cursor’s position. You can move this window or close it 
as required. For more information see the on-screen Help.

The top left corner of the Historical Graph tells you how the data is displayed  
– this may say “Pounds 4 week bars (dyn.)”. This means that the values on the 
left and right-hand side of the graph are in pounds, that each bar on the graph 
represents 4 weeks’ worth of data and that the data is displayed dynamically. 
With dynamically displayed data, ShareScope will choose the best way to display 
the data.  As you zoom in on the graph you will see this change. You can also 
set ShareScope to always display the same period (for example the last six 
months). This is the Limit Date Range : Set Date Range option on the Graph 
context menu (see below).

The default setting for the Historical Graph shows OHLC bars with trend and 
confidence lines, a 20-period moving average and a volume histogram. Note that 
the volume data only starts from June 2000 and is not available before this date. 

Right-click anywhere within the graph screen. This brings up the Graph context 
menu which displays the options available for configuring the Historical Graph. 
To customise how the data is displayed and the colours used on the chart, select 
Graph Design from the context menu. Close this dialog for now by clicking 
Cancel.

Just like the List Tables, ShareScope provides 12 Graph Settings. This enables 
you to apply different views to the same price chart without having to change 
the configuration each time. At the bottom of the screen you will see that there 
are shortcut buttons for some of these (e.g. Setting 1, Setting 2). Click on 
the Graph Settings menu to access all 12 and have a look at some of them. 
ShareScope will automatically remember the changes you make to them.

Here are some examples of how members use Graph Settings:

To look at the same price chart with different time frames, e.g. one month, 
3  months, 6 months, one year.

To show different moving average (MA) combinations e.g. 10/30 MAs, 
30/50 MAs, 100/200 MAs.

To show different technical indicators e.g. swing charts and point & figure.

You can add a vast array of technical indicators to ShareScope’s Historical 
Graph and these can be accessed via the options on the Graph context menu. 

We will now look at the Intraday Graph. Press Enter to change to this screen. In 
ShareScope Gold the Details screen comes next (see page 10).

•

•

•
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Intraday Graph
ShareScope Plus/Pro only

The Intraday Graph shows the price movement and trades of the currently 
selected share throughout the day. You need to be connected to the intraday 
feed to see this information. Press the Connect toolbar button (depicting 
lightning) if you are not already connected.

Look in the title bar of the graph and you will see that it says “Intraday Graph” 
and tells you which list of shares is being used, the sector, the Graph Setting and 
whether the window is linked (see page 5).

Like the Historical Graph, the Intraday Graph has a Legend showing extra 
information such as the mid, bid and offer prices for a given time.

Initially Intraday Graphs are set up to show just one day’s data but they can 
show up to 10 days’ worth. When you first install ShareScope you do not have 
any intraday history so you will need to backfill the data in order to show more 
than the latest day (see page 4). 

The graph is currently showing you the bid (darker blue shading) and offer 
(lighter blue shading) prices with a blue mid line through the middle. The dots 
represent the trades – green for buy, red for sell and blue for unknown trade 
types. The volume of each trade is shown in the histogram below the graph. To 
zoom in on a specific period on the graph, left-click and drag your mouse cursor 
to highlight the period you wish to view, then let go of the mouse. To return to the 
full day, double-click with your mouse in the middle of the graph.

As in other screens, right-click in the middle of the graph to view the options 
available on the context menu. From this menu you can add Moving Averages, 
Trend Lines, Indicators, Market Graphs, Stop-loss (from the Other Main Graph 
Features option) and numerous line studies. To change the way the bid, offer 
and trade data is displayed on the graph select Graph Design.

As with Historical Graphs, there are 12 Graph Settings for the Intraday Graph. 

You can also use the Intraday Graph toolbar button (depicting a red and blue 
graph) to view this screen.

Press Enter to move on to the Details screen.

Details screen
The Details screen displays a detailed breakdown of underlying financial 
performance, structure and stability. The screen is comprised of list boxes, 
results tables, historical price graphs and results graphs. 

Just as with the Historical Graph and List screens, the options available for 
the Details screen can be accessed using the context menu. This is always 
the fourth menu from the left on the menu bar on any screen. It can also by 
accessed by right-clicking anywhere in the central part of the current screen. The 
options for the Details screen include adding new boxes to the window, adding 
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items to the boxes and changing the design of the boxes.

There are 12 Details Settings you can use to organise different information – 
use the toolbar buttons at the bottom of the screen to view some examples. For 
instance, the Main setting (the default) gives you a comprehensive description. 
To view all 12 settings, go to the Details Settings menu at the top of the screen. 
Any changes you make will be saved when you close ShareScope.

You can also click the Details toolbar button (depicting a magnifying glass) to 
display this screen.

Press Enter to return to the List screen, thereby completing the cycle of screens.

Portfolios
Creating a portfolio
You can create an unlimited number of portfolios or watch lists in ShareScope 
to maintain your investments and to make comparisons of their performance 
against any share, index or other portfolio.

Note that in ShareScope Plus/Pro you have the additional options of changing 
any of the windows on the screen into a portfolio, or adding a new window to 
your layout. For now though we will use the existing window.

To create a portfolio:

Press F12. This is a shortcut key for going to the View Portfolio dialog. 

Click on the New portfolio button in the dialog box.

Type in a name for your portfolio and click on OK.

You have now created a blank portfolio which you can access in future by 
pressing F12. You could also go to the Portfolio menu, choose Select portfolio 
and then choose the portfolio you want to view from the list. There is also the 
Portfolio : Current portfolio option (or F11) – the current portfolio will always 
be the one you looked at last.

The Portfolio screen replaces the List screen in the view cycling – so press Enter 
to scroll through from the Portfolio screen to Historical Graph to Intraday Graph 
(if applicable) to Details and then back to the Portfolio screen.

Adding shares to your portfolio
There are various ways of adding shares to a portfolio. Once you have created 
a portfolio, right-click in the portfolio screen and select Add share to portfolio. 
This will display the Find a Share dialog (see pages 4 (ShareScope Gold) and 7 
(ShareScope Plus/Pro)). Type in the name of the share to add it to the portfolio. 
You can also do this by pressing Ctrl and A.

Have a look at the status bar at the top of the Portfolio screen. It tells you the 
following information:

The name of the portfolio.

The number of shares in the portfolio.

1.

2.

3.

•

•
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The average price of the shares in the portfolio.

The average increase/decrease in price (daily) of the shares.

The percentage increase/decrease in price (daily) of the shares.

The total capitalisation of companies owned/held in the portfolio.

The average capitalisation of companies owned/held in the portfolio.

Currency of the portfolio.

Recording transactions
To record a transaction against a share in your portfolio go to the Portfolio screen 
and left-click on the share to select it. Now right-click and select Buy from the 
context menu. ShareScope automatically enters the previous day’s close price as 
a guide. Enter the number of shares and any broker charges or stamp duty paid. 
You can back-date your transactions so that you can create any portfolios you 
already have.

The transaction information is stored in the Transactions screen – each portfolio 
has its own. To view this screen, right-click in the portfolio screen and select 
Transactions. Use F11 to return to the Portfolio.

You may notice that the summary line just above the column headings is different 
in the two screens. In the Portfolio screen, the summary gives you information 
about the shares in the portfolio – the average price and up/down movement as 
well as the capitalisation. In the Transaction screen the summary line gives you 
information about your holdings – the value and increase/decrease in value as 
well as any potential or realised profit or loss. You can also get the Transactions 
Summary in the Portfolio screen by selecting Portfolio : Investment Portfolio. 
Now click on the All toolbar button (ShareScope Gold) or the FTSE 100 button 
(ShareScope Plus/Pro) to return to the List screen (showing these shares).

Data Mining
Data Mining is ShareScope’s powerful stock screening utility. It enables you to 
search the stock market for shares that meet specific criteria. To access Data 
Mining use the Data Mining toolbar button (depicting a pickaxe and shovel). 

The Data Mining screen is comprised of three areas:

The control panel on the right where the Data Mining filters are selected 
and configured.

The list of shares identified by the filter.

The graph which shows the distribution of the shares according to three of 
the search criteria.

For information on selecting, editing and creating Data Mining filters see 
ShareScope’s Help facility (see page 14). You may also be interested in 
purchasing our Become an Expert at Data Mining CD – more information about 
this is available on our website.

•

•

•

•

•

•

•

•

•
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Like the Portfolio screen, the Data Mining screen also replaces the List screen in 
the view cycling – so press Enter to scroll through from Data Mining to Historical 
Graph to Intraday Graph (if applicable) to Details and back to Data Mining. For 
now click on the All (ShareScope Gold) or FTSE 100 (ShareScope Plus/Pro) 
toolbar button to return to the List screen.

Level 2
Level 2 is the professional data screen used by stockbrokers and City traders. 
Level 2 is included in ShareScope Pro by default. If you have ShareScope Gold 
or ShareScope Plus you can subscribe to Level 2 as an optional extra. See our 
website for subscription details. If you don’t have Level 2 please go to the next 
section.

To view the Level 2 screen, click on the Level 2 toolbar button (showing a 
black and yellow screen) or press the # (hash) key. You will see a black screen 
with a yellow strip across it. Now you need to connect to the live Level 2 data 
feed. There is a toolbar button for this (the black/yellow screen with lightning), 
alternatively you can select Connect to Level 2 data feed from the Comms 
menu. 

The Level 2 screen shows you the “order book” with the actual prices and 
volumes of shares being bid for or offered on the LSE. The “yellow strip” shows 
the best buy and sell prices, the number of orders at those prices and the 
volume of shares available. There are also graphs showing prices and volume.

As with all other ShareScope screens, you can right-click to access the context 
menu. The Level 2 design option allows you to customise the appearance of the 
screen and to specify what information is displayed.

You can find out more in the Introduction to LSE Level 2 InfoCentre document 
and in the on-screen Help. You may also be interested in our Using Level 2 to 
Improve Your Trading CD – more information about this is on our website where 
there is also a short video about Level 2.

Press the # key to exit the Level 2 screen and return to the previous screen.

Additional screens in ShareScope
In addition to the screens we have covered so far, ShareScope offers even more 
information to help you with your investment decisions. The following options are 
available for the currently selected share.

Directors’ dealings
ShareScope lists directors’ dealings and holdings, as well as major shareholdings 
and major shareholders’ dealings. This is particularly useful in tracking individual 
companies, but can also be used to see what a particular investment company 
is investing in. You can access this information by pressing . (full stop) from any 
screen. Press it again to return to where you were.
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News
To read news stories about a share press \ on your keyboard and \ again to 
return. Note that there will be no news stories until after your first update. 
Double-click on a story to read it.

Share’s dates
Press > to see the important dates (e.g. AGM) for a company. Press > again to 
return.

Price List
Press / to see a list of daily OHLC prices for the selected instrument. Press / 
again to return.

Trade Summary (ShareScope Plus/Pro only)
Pressing ? displays an up-to-the-minute breakdown of trade count, value and 
volume for a share in terms of buys, sells, and unknowns for the selected share. 
Press ? to return.

Trade List (ShareScope Plus/Pro only)
ShareScope provides a full history of trades and quotes for the currently selected 
share. Press the ’ (apostrophe) key to go to this screen and again to return to 
the previous screen.

For more detailed information on all of these screens, please see the on-screen 
Help (details below). 

As you will have discovered, wherever you are in ShareScope, most information 
is never more than a mouse click or key press away. In fact there is often more 
than one way of accessing information (i.e. menus, toolbar buttons and shortcut 
keys) so that you can use the method that best suits you.

ShareScope Plus/Pro members, don’t forget that once you have finished this 
tutorial you can restore your window layouts to their orignal configuration. See 
page 6.

ShareScope Help
All ShareScope features and menu items are explained in ShareScope’s on-
screen Help. This can be accessed in a number of ways:

Using the Help – Contents and Search facility on the Help menu you 
can search for specific words or phrases.

Many dialog boxes include a Help button which will display the relevant 
Help page. Similarly, many dialog boxes include a “?” button in the top 
right-hand corner. Click on this button and then click on any item within 
the dialog box to display context-sensitive Help.

Use the F1 key to display context-sensitive Help. For example if you 
hover the mouse over an item on a menu and then press F1, the relevant 
Help will be displayed.

Don’t forget Tip of the Day and What’s New.

•

•

•

•
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InfoCentre contains educational articles to help you get the most out of 
ShareScope. To access this feature select View : InfoCentre.

You can also discuss ShareScope and investing techniques with other 
members on our discussion boards. You will find a link to these on the 
Help menu.

If you require further assistance please contact the ShareScope Support team:

ShareScope Gold/Plus Support 
call 0845 045 0111 (or alternatively 020 7549 1104) 
email support@sharescope.co.uk 
09:00 – 18:00 Monday to Friday

ShareScope Pro Support 
call 0845 456 0545 (or alternatively 020 7549 1103) 
email pro@sharescope.co.uk 
08:00 – 18:00 Monday to Friday

What else can you do with ShareScope?
We have only covered a tiny fraction of ShareScope’s functionality in this tutorial. 
To get the most out of ShareScope, we suggest you look at the on-screen Help. 
The What’s New pages are a good starting point. ShareScope Support can also 
help. Features available in ShareScope include:

Alarms – there are extensive options for setting alarms on intraday prices 
(ShareScope Plus/Pro only) and closing prices.

Events – display key transactions and events on your Historical and 
Intraday Graphs including news items.

Import – add data to ShareScope either manually or from a file.

Export – save data from ShareScope to use in another program, e.g. 
Excel.

Customisation – all screens and toolbars can be customised so that you 
can set up ShareScope to suit your needs.

Use heat maps in List screens to give an at-a-glance overview of the 
market.

Automatic update – this facility checks whether your data is up-to-date 
and updates it if it is not.

Set up Cash Accounts to keep track of cash associated with your 
investments.

Comprehensive Capital Gains Tax coverage including a CGT calculator. 

•

•

•

•

•

•

•

•

•

•

•
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Notes
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Shortcut keys

Function 
key

Shift Ctrl Shift and Ctrl 
together

F1 Context 
sensitive Help

Help arrow

F2, F3, F4 List Tables or 
Graph Settings

List Tables 
or Graph 
Settings

List Tables 
or Graph 
Settings

List Tables 
or Graph 
Settings

F5 All shares, 
indices etc

FTSE 100 Non-index Convertibles

F6 Ordinary 
shares

FTSE 250 AIM Income 
shares

F7 Investment 
trusts

FTSE Small 
Cap

Warrants Capital shares

F8 Indices FTSE 
Fledgling

Preference 
shares

Other shares

F9 Update data Details Historical 
Graph 

Current cash 
account

F10 Select the 
menu

Context menu Context menu

F11 Current 
portfolio

Imported data Directors’ 
dealings

Select cash 
account

F12 Select portfolio Data Mining Email Triggered 
alarms

General
a–z (and 0–9) Find a Share or Search (in News screen)
Enter Historical Graph > Intraday Graph > Details > List > 

Historical Graph
Esc Historical Graph > List > Details > Intraday Graph > 

Historical Graph
Space Next item in current list
Shift and Space Previous item in current list
/ Numerical price history for selected share ( and / 

again to close)
\ News for selected share (and \ again to return to 

previous screen)
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| News screen (all stories)
. (full stop) Directors’ dealings for selected share (and return to 

previous screen)
, (comma) View current list (except Transaction screen)
’ (apostrophe) Trade List (and again to return to previous screen) 

ShareScope Plus/Pro

# Level 2 screen (and again to return to previous 
screen)

> Company dates
+ (on number pad) Transactions screen
-  (on number pad) Current portfolio
= Maximise/minimise current window (ShareScope 

Plus/Pro)

Ctrl and A Add share to current portfolio
Ctrl and B Back up ShareScope
Ctrl and C Copy to the clipboard
Ctrl and D Design dialog
Ctrl and P Print
Ctrl and Q Quotes list (and return to previous screen) 

ShareScope Plus/Pro

Ctrl and R Restore window layout from disk (ShareScope Plus/
Pro)

Ctrl and S Save
Ctrl and T Trade list (and return to previous screen) ShareScope 

Plus/Pro

Graph screens
Left/right arrows Move cursor back/forward one trading day
Shift and left/right 
arrows

Scroll graph left/right

Shift and click and 
drag

Draw a straight line

Ctrl and click and 
drag

Draw a partial trend line

Alt and Enter Add a text box
Tab Select next line or text box
Delete Delete selected line or text box
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Shift and Delete Delete all lines and text boxes
Shift If a share’s price has been adjusted, show 

unadjusted price on status bar (Historical Graph)
Shift and 1 Display 1 month on the graph (Historical Graph)
Shift and 2 Display 3 months
Shift and 3 Display 6 months
Shift and 4 Display 1 year
Shift and 5 Display 2 years
Shift and 6 Display 5 years
Ctrl and 1 Show 1 day bars (Historical Graph)
Ctrl and 2 Show 2 day bars
Ctrl and 3 Show 3 day bars
Ctrl and 4 Show 4 day bars
Ctrl and 5 Show 1 week bars
Ctrl and 6 Show 2 week bars
Up/down arrows Compress or expand the vertical scale of graph
Shift up/down arrows Move the graph up or down the vertical axis
Ctrl and X Fix position of crosshairs

List screens
Left/right arrows Scroll columns left/right (if they don’t fit on the 

screen)
Double click on 
column heading

Sort list by that column (double-click to reverse 
order)

Shift Home/End Select first/last item in current list
Page down/up View next/previous page of current list
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Portfolio and Transaction screens
Delete Delete selected share or transaction
Ctrl and Z Undo – e.g. if you have deleted an item or made a 

transaction in error
Ctrl and Y Redo – i.e. after undoing it

Portfolio screen only
Shift and Delete Delete all items

Transaction screen only
+ View “Latest” lines
, (comma) CGT report for current year
< CGT report for selected share

News screen
Enter View selected story
Esc Show all news stories
a–z (and 0–9) Search news
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